
 :فصل اول 
 dialux 2.0واسطه كاربر 

 : به چهار محيط كار اصلي تقسيم شده استdialux 2.0واسطه كاربر 
 CAD پنجره -

 درخت پروژه -
  راهنما -
 كنترل كننده-

فراهم  dialux 2.0اين چهار محيط طرح ريزي موثر جايابي تاسيسات روشنايي را توسط 
وانيد در هركدام از اين محيط ها به توابع نرم افزاري ويژه دسترسي شما مي ت.مي سازد

 .پيدا كنيد و يا اشيا ويژه اي را ويرايش كنيد



 :CAD پنجره 

 
 3Dنماي نقشه مسطحه                                                           نماي 

مي توانيد از نماهاي مقابل همچنين ,)ground plan( و نقشه مسطحه3Dعلاوه بر نماهاي 
 CADپنجره .براي طرح ريزي تعاملي استفاده كنيد) side(و پهلو

با استفاده از موس مي توانيد .طرح ريزي تعاملي طرح بندي روشنايي را فراهم مي سازد
انتخاب هاي .كنيد )) rotate (( ,)) zoom((,))move(( ,))roam((به صورت گرافيكي 

))PAN (( يا))move (( اغلب توسط كليد وسطي موس دست يابي مي شوند و اگر شما از
با )) zoom((انتخاب ,استفاده مي كنيد) wheel mouse(موس هاي چرخان

 .علامت گذاري شده است) wheel(چرخش
كليد سمت راست موس از اهميت ويژه اي ,  كار مي كنيدdialux 2.0 هنگامي كه با

سبك برنامه و محيط كار انتخابهاي ,شدهبسته به شئ انتخاب .برخوردار مي باشد
 .متفاوت و مهمي دستيابي مي شوند

 كليد سمت راست موس



مقياس گذاري كنيد  بچرخانيد , علاوه بر اين مي توانيد اشيا را داخل اتاق جابهجا كنيد
 مي تواند به CAD كه توسط آن پنجره contextبراي دستيابي به منوي .يا انتخاب كنيد

 . ئيچ شودسبك مطلوب سو

 
 3D CAD براي پنجره contextمنوي 

 

 
 براي نماي نقشه مسطحهcontext  منوي 

فقط در نماي نقشه )) …Dxf(( و insert)(الحاق,luminaires)(انتخاب هاي روشنايي ها
فقط در نماي ) Adjust Brightness(انتخاب تعديل درخشش.مسطحه در دسترس هستند

  3D3 روژه مي توانيد براي تغيير بين نماهاي در محيط درخت پ.وجود داردD, نقشه
باز  CADاگر بيش از يك پنجره .پهلو و مقابل در داخل اتاق راست كليك كنيد,مسطحه

شما مي توانيد آنها را توسط منوي پنجره همان طور كه مي خواهيد مرتب ,بود
ه نماي ديگري  در پايين صفحه ب tabاگر پنجره تمام صفحه بود مي توانيد بوسيله .كنيد

كار كردن همزمان با پنجره هاي متعدد فقط در هنگام كار با وضوح .آن را تبديل كنيد
اگر يك شئ به يك اتاق .بالاي تصوير و يك وفق دهنده خوب تصوير توصيه شده است

 . آن نيز توسط راست كليك كردن به دست مي آيدcontextمنوي ,اضافه شده است



 
 نتخاب شده براي شئ ا contextمنوي 

شئ با كليك كردن و چرخانـدن نقطـه         ,در صورتيكه گزينه چرخيدن انتخاب شده باشد      
نقطه دوران قرمز چرخش حول محور قرمز و نقاط دوران سـبز            .پايين چرخانده مي شود   

 بـه خـاطر     "لطفـا .و آبي به ترتيب دوران حول محورهاي سبز و آبي را ممكن مي سازند             
شـئ مـي توانـد بـا كليـك كـردن و             .ودش را دارد  بسپاريد كه شئ سيستم مختصات خ     

 .حركت كند) arrow cross(كشيدن نشانه هاي طرفي



 :درخت پروژه

 
 درخت پروژه

درخت پروژه جريان كاري سريعي را به همراه المانهاي استفاده شده در طرح روشنايتان 
 Theدر هر المان منحصر بفردي مي تواند انتخاب و خواص آن مي تواند .فراهم مي كند

Inspectorدر اين مثال پروژه. مشاهده و اصلاح گردد "DIALux2", ناميده شده و اطلاعات
و همچنين تمـام اتاقهـا و روشـنايي هـا را            , كلي آن مانند نام و آدرس اپراتور و مشتري        

كليه روشنايي هاي استفاده شـده در پـروژه و          ,در ليست روشنايي ها     .سازمان داده است  
در اينجـا روشـنايي     .براي استفاده انتخاب شده اند ليست شده اند        pluginآنها كه از يك     

هاي جايگزين كه هنوز در اين طرح بندي روشنايي استفاده نشده اند نيز سازمان دهـي        
 .شده اند

 :اتاق از بخش هاي مقابل تشكيل شده است
 )سقف و كف(سطوح تعريف كننده اتاق

 سطح كار
 چيدمان اثاثه و روشنايي ها



 Inspectorرتيكه يكي از اين المان ها را با كليك چپ انتخاب كنيد خواص آن در                در صو 
را براي شئ   contextمنوي ,CADمشابه نماي ,كليك راست كردن.نمايش داده مي شوند

 .باز مي كند



 :انتخاب روشنايي ها
ساختار درخت گونه ديگري براي انتخاب روشنايي ها وجود دارد كه با كليك كردن 

 . در پايين درخت پروژه نمايان مي شودtab ((luminaire selection)) روي
 

 
 pluginدرخت 



plugin هاي نصب شده به طور اتوماتيك با dialux 2 به رسميت شناخته مي شوند و 
روي يك . نمي باشد.X.1 ها بعد از به روز كردن  pluginنيازي به دوباره نصب كردن 

plugin همچنين مي توانيد از طريق منوي,ا باز كنيد دبل كليك كنيد تا آن ر 
 luminaire selectionبه اين گزينه دسترسي پيدا كنيد . 

Plugin هاي فراهم شده توسط شركاي ما و آنچه تا كنون نصب نشده كمي پايين تر 
 كه تا كنون نصب نشده است دبل  pluginاگر روي يك .درساختار درخت قرار گرفته اند

 كارخانه سازنده Intenet Explorer, home pageي شود كه پنجره كليك كنيدباعث م
در آينده برخي سازندگان روشنايي هاي .نمايش دهد,اگر در دسترس باشد,روشنايي را 

 . كردن از اينجا در اختيار ما قرار مي دهندdownloadمنحصر به فردي را براي 



 ):The user database(پايگاه داده كاربر
 هاي گوناگون فراهم شده توسط سازندگان را كه اغلب مورد pluginند كاربر مي توا

)) پايگاه داده كاربر((اين روشنايي ها مي توانند در . استفاده قرار مي گيرد انتخاب كند
.  همچنين جستجو و پاك كردن روشنايي ها نيز ممكن مي باشد,ذخيره شوند

DIALUX 2.0 ها در  به طور قرار دادي شامل دموي روشنايي ))user database (( مي
اين ها مي توانند با روشنايي هاي واقعي فراهم شده توسط سازندگان جابه جا و .باشد

 .جايگزين شوند

 
 پايگاه داده كاربر

از هر .استفاده كنيد)) Import ((از كليد))پايگاه داده كاربر((براي انتقال روشنايي ها به 
 مي توانند وارد ULD" , *.ldt, *.ies or *.cib" دايركتوري دلخواهي يك يا چند فايل

 در ليست روشنايي ها ظاهر شده "مثلا-اگر يك روشنايي وارد شده به پروژه.شوند
 .مي تواند با راست كليك كردن به پايگاه داده شخصي كپي شود-باشد



 :DIALUX 2.0وارد كردن فايل هاي روشنايي به 

 
 . در حال اجرا مي باشدDIALUX 2.0 ماداميكه context Explorerمنوي 

 در بك گراند در حال اجرا مي باشد مي توانيد هر دايركتوري DILUX 2.0هنگاميكه 
دلخواهي را براي داده هاي روشنايي جستجو كنيد و آنها را به به پروژه جاري وارد 

يا آنها را به پايگاه داده شخصي تان با راست كليك كردن روي فايل وارد ,كنيد
 : فرمت هاي مقابل را ساپورت مي كند DIALUX.دكني

Eulumdat (ldt)- 
-CIBSE 
-TM14 
-IES (all variations) 
-LTLi 
-PDF (manufacturer-specific format)  



 :درخت اثاثه
  موس منتقل drag & drapبا استفاده از )هر نمايي(اثاثه مي تواند از درخت اثاثه به پروژه

 .شود

 
 درخت اثاثه

اينها فايل هاي اثاثه كامل يا اثاثه خود . اثاثه به سه زير شاخه تقسيم شده استدرخت
شما همچنين مي توانيد فايل هاي اثاثه را از ديگر سازندگان به .ساخته مي باشند

علاوه بر اين اشكال هندسي استاندارد مثل ,  ذخيره كنيد SAT.*صورت فايل هاي  
آنها درها وپنجره هاو , ))diverse objects ((با نام,موجود هستند... منشور و,مكعب

 .كلكسيون سطوح مجازي هستند



 : درخت خروجي
شما مي توانيد آن را باكليك كردن .درخت ديگري براي انتخابهاي خروجي وجود دارد

انواع خروجي كه با تيك قرمز روي آيكون . در درخت پروژه باز كنيد))tab)) outputروي 
خروجي هاي بدون تيك قرمز . واسطه در دسترس هستندصفحه مشخص شده اند بي

 .فقط بعد از انجام محاسبات بدست مي آيند

  
 درخت خروجي

براي مشاهده .براي ديدن يك خروجي روي صفحه روي آيكون متناظر دبل كليك كنيد
 راست كليك كنيد و outputانواع خروجي به طور همزمان روي آيكون 

open in new window شما مي توانيد انواع خروجي ها را روي صفحه .خاب كنيد را انت
استفاده شده اند   File -> Print Preview يا File -> Print  زمانيكه فرمان هاي.ببينيد

فايل هايي كه در مربع كناري آنها علامت تيك خورده است پرينت يا به عنوان پيش 
توسط  CADر نماي موقعيت ناظر استفاده شده د.پرينت نمايش داده مي شوند

3Dخروجي استفاده شده است . 



 :راهنما
 GUIDEاين به عنوان . به همه پله هاي لازم براي طرح دسترسي دارد"مستقيما

 . به هدف خود برسند"به كاربران كمك ميكند تا سريعا)) ريسمان اتصال دهنده((

 
 The Guide)  (راهنما 

 . به دست مي آيد"نه متناظر مستقيماكليك كنيد گزي   Guideاگر روي يك آيكون در 
نگه داريد  )) Position  Luminaires((يا )) Create Room((نشانگر موس را بالاي آيكونهاي

كليه گزينه هايي كه براي وارد كردن روشنايي ها يا اتاقها لازمند در قسمت راست 
 عنوان مثال به,آيكون شروع آخرين گزينه استفاده شده مي باشد.آيكون ظاهر مي شوند

))Insert single  Luminaire (( آخرين بار استفاده شده است. 



 ): The Inspector(بازرس
يارخت پروژه CAD در اين بخش مي توانيد ويژگي هاي هر شئ انتخاب شده در پنجره 

 .در اينجا همچنين مي توانيد خواص را تغيير بدهيد.را ببينيد

 
 Inspectorدر صفحه ويژگي هاي اتاق انتخاب شده 

 tabروي .در تصوير قبل مي توانيد ويژگي هاي مختلفي از اتاق انتخاب شده را ببينيد
))Room Surface(( توجه داشته .كليك كنيد تا خواص ضريب انعكاس را تغيير بدهيد

در .باشيد كه در اينجا مي توانيد ضريب انعكاس همه ديوار ها را با هم تغيير دهيد
 ضريب انعكاس ديوار خاصي را تغيير دهيد بايد ديوار متناظر را صورتيكه مي خواهيد

 . تغيير دهيد Inspectorانتخاب و سپس خواص آن را در 
 بين روشنايي ها و آرايش روشنايي ها فرق قائل Inspectorبه خاطر داشته باشيد كه 

 .است

 
 آرايش روشنايي ها و روشنايي هاي آن در درخت پروژه



 
 صفحه ويژگي ها براي آرايش روشنايي ها)) positon((گزينه 

 
 صفحه ويژگي هاي  روشنايي هاي انتخاب شده

DIALUX 2.0 هنگاميكه گزينه هاي معيني استفاده شده باشند به يك مد ويرايش 
براي مثال هنگاميكه ابعاد اتاق بايستي در مرحله آخر تغيير پيدا كنند .سوئيچ مي شود

را انتخاب   Edit Room Dimensionsپروژه روي اتاق و در درخت .اين اتفاق مي افتد
 مي Editدر منوي  Edit Room Dimensionsراه جايگزين كليك روي گزينه ,كنيد



توصيه .مي باشد)) Guide(( در Edit Room Dimensionsسومين راه كليك روي .باشد
 .تغيير دهيد)) نقشه مسطحه((شده كه ابعاد اتاق را در نماي 

 
 Edit Room Dimensions  به مدDIALUX                                                                               سوئيچ         

 
 )Roomدبل كليك روي ( اتاقcontextمنوي 

 .نقشه مسطحه اتاق مي تواند اصلاح شود,پس از آنكه اين گزينه به دست آمد



 
 مد ويرايش اتاق

روي ديوارها آنها به صورت تعاملي موازي با موقعيت قبلي شان در نماي با كليك كردن 
CADبراي جا به جا كردن آنها به موقعيت مطلوب ديگري روي . جا به جا مي شوند

 .مختصات اتاق كليك كنيد
 با كليك روي ستون مختصات و Property Pageمختصات ثانويه اتاق مي تواند در 

همچنين مي . اضافه و يا پاك شودDelete coordinatesيا  Insert coordinates  انتخاب 
 و Length اتاق را از طريق  maxابعاد .توانيد مختصات را به صورت عددي وارد كنيد

Widthوارد كنيد . 
روشنايي در پايين سمت چپ بعد از بكار گيري , توجه كنيد در تصوير قبل "لطفا

اگر اتاق دوباره بزرگ شود روشنايي .دمختصات جديد نشان داده و محاسبه نخواهد ش
 .ها به طور اتوماتيك دوباره وارد خواهند شد

 



 :فصل دوم
 الحاق اثاثه

 : Drag & Dropوارد كردن اثاثه بوسيله 
سپس , در درخت كليك چپ كنيدFurnitureبراي وارد كردن يك وسيله به اتاق روي 

 داخل X , Yكليد موس را فشار داده و نگه داريد تا نشانگر موس به موقعيت مطلوب 
 . تعيين مي گرددCtrl در مرحله بعد حين فشار كليد  Zموقعيت . اتاق برسد

 
 Drog and Dropاثاثه 

 ارتفاع با 3Dدر نماي . مي تواند به صورت گرافيكي تغيير كندsideارتفاع اشيا در نماي 
 . تغيير مي كندCtrlكليك حين فشار 



 Property Page:وارد كردن اثاثه از طريق 
 Furnitureهمچنين مي توان اثاثه را به صورت عددي با وارد كردن مختصات در 

Property Pageبه اتاق وارد كنيد . 

 
Property Pageبراي وارد كردن اثاثه  



 :فصل سوم
 : كار كردن در نماهاي گوناگون

DIALUX 2.0نماهاي گوناگوني را براي ياري شما در طراحي تان فراهم مي كند . 

 
Toolbar نماها  

 مصور باز كنيد توابع از چپ به راست toolbarمي توانيد نماهاي مختلفي را از طريق 
 :عبارتند از

• Cascade views  

• Tile windows vertically or horizontally  

• Open 3D view 

• Open ground plan view 

• Open side or front view 

• Switch 3D view wireframe mode on or off 

• Switch 3D view perspective on or off 

 

 



 اهاي مختلفكار كردن در نم

توير بالا مي تواند ابتدا با باز كردن چهار نما و سپس منظم كردن پنجره ها به دست 
 .آيد

 .اگر مونيتور شما به قدر كافي بزرگ است بهتر است نماهاي متعدد همزمان باز باشند

 
 آرايش نماهاي متعدد

 . در گوشه بالا سمت راست كليك كنيد تا  پنجره را ببنديدXروي آيكون 

 
 CADبستن پنجره 

 
 



 :فصل چهارم
 : ويرايش اشيا وارد شده

 :حركت دادن اشيا
پس از آنكه اثاثه و روشنايي ها داخل اتاقجا داده شدند مي توانند به صورت دلخواه 

 CADتمام اطلاعات مربوط به شئ انتخاب شده در درخت پروژه يا نماي .ويراست شوند
دن ارزشهاي جديد شئ مي تواند با وارد كر. نمايش داده مي شودInspectorتوسط 

 چرخانده يا جابه جا شود يا تغيير مقياس CADهنگاميكه يك شئ در نماي .اصلاح شود
 . به روز ميشوندInspectorدهد مقادير در 

 
 تغيير ارتفاع شئ به صورت گرافيكي

 

كليد را فشار .را فشار دهيدCtrl   كليد Zبراي اصلاح موقعيت يك شئ در امتداد محور 
تا زمانيكه كليد . در شئ كليك مي كنيدarrow crossد  تا زمانيكه روي داده نگه داري

Ctrl  و كليد سمت چپ موس فشار داده هستند فقط ارتفاع اشيا مي تواند تغيير 
 . را اصلاح كنيد X ,Y را رها مي كنيد مي توانيد موقعيت Ctrlوقتي .كند



 :pick gridحركت دادن و چرخاندن اشيا بدون 
اشيا فقط داخل شبكه چيده شده از قبل جا , توسط موس جا به جا ميكنيدوقتي اشيا را

 pick , را فشار دهيد shiftاگر هنگاميكه شي را جا به جا مي كنيد كليد .به جا مي شوند

gridتنظيمات .خنثي مي شودgridرا مي توان در  
 CAD -> Set Pick Gridاز پيش تعيين كرد . 

 
  pick grid تنظيمات 



 :دن اشياچرخان
براي چرخاندن اشيا آنها را ابتدا انتخاب مي كنيم و سپس به صورت عددي در 

Property Page يا به صورت گرافيكي درنماي CADروي يكي از سه . تغيير مي كنند
 يك شبكه چرخش تحت عنوان,نقطه چرخش محورها كليك كنيد

 Angle Pickكه اين با.اشيا حول مبدا مختصات خود مي چرخند. وجود دارد 
 arrow crossاگر اشيا متعددي . و توسط نقطه نقاطع سه محور نشان داده شده است

 .براي چرخيدن انتخاب شده باشند آنها حول مكعب محاطي مي چرخند

 
 چرخاندن اشيا



 :مقياس گذاري اشيا
 Propertyدو يا سه محور مقياس گذاري شوند اينكار در ,اشيا مي توانند در امتداد يك

Page يا CADبراي رفتن به مد . انجام مي شودScale در CAD منوي context اشيا را با 
 . را انتخاب كنيدScaleراست كليك كردن باز كنيد و گزينه 

 
  اشياcontextمنوي 

 با كليك كردن و كشيدن يكي از X,Y,Z مي توانيد اشيا را در جهتهاي 3Dدر نماي 
اگر روي يكي از نقاط .مقياس گذاري كنيد از شئ انتخاب شده rubberbandخطوط 

آن را به طور همزمان در تمامي جهت ها مقياس ,گوشه اي انتخاب شده كليك كنيد
 .گذاري مي كنيد
 مقياس گذاري در يك بعد = rubberbandكشيدن خطوط 

 مقياس گذاري در سه بعدrubberband = كشيدن گوشه هاي 



 :تركيب و ذخيره اشيا
 الحاق كرده ايد كه مي خواهيد با آنها مانند يك آرايش CAD را در اگر اشيا متعددي

اشيا نيازي به تماس .رفتار كنيد يا آنها را ذخيره كنيد بهتر است آنها را تركيب كنيد
 .براي تركيب شدن ندارند آها همچنين مي توانند مستقلانه در يك اتاق قرار بگيرند

 
 تركيب اشيا

انتخاب كنيد براي contextرا از منو  combineنتخاب كنيد براي تركيب اشيا آنها را ا
 .را انتخاب كنيد…context ،save asذخيره اشيا آنها را انتخاب كنيد و از منو 

 : مهم 
Dialux 2.0   فقط اثاثه ذخيره شده در دايركتوري\DIALux2.0\Furniture\ را در درخت 

ر دايركتوري را در دايركتوري كاربر مي تواند شاخه هاي زي. مي كند loadاثاثه 
\Furnitureاگر شما فايل هاي اثاثه با فرمت . بسازد*.SAT  از سازندگان دريافت كرده ايد

 .مي توانيد آنها را در دايركتوري اثاثه ذخيره كنيد و از آنها استفاده كنيد



 :حركت دادن مبدا مختصات يك شئ
محاطي به طور اتوماتيك مبدا اگر اشيا متعددي را تركيب كرده ايد مركز مكعب 

 را Altهنگامي كه مبدا مختصات شئ تان را حركت مي دهيد كليد .مختصات مي شود
براي تغيير ارتفاع يا .فشار دهيد،مبدا مختصات شئ به جاي خود شئ جا به جا مي شود

اگر الان شئ را ذخيره . استفاده كنيدctrlو  shift از كليد هاي  pick gridخنثي كردن 
 .يد مبدا مختصات جديد نيز ذخيره مي شودكن

 
 .مبدا مختصات به خارج از مكعب منتقل شده است



 :ويرايش سطوح اشيا
 مي توانيد از هر رنگي استفاده كنيد،ضريب انعكاس،مصالح و محاسبات dialux 2.0در 

اشيا شئ را انتخاب كنيد و براي ويرايش سطح .براي هر سطحي شبكه بندي شده اند
 . را فشار دهيدsurfaceتب 

 
 ويرايش سطوح

اگر سطحي را . صفحه خواص با ليستي از سطوح موجود نمايان مي شودInspectorدر 
در . تيره و روشن مي شودrubberband با  CADدر ) surface 70در اين مثال(انتخاب كنيد
صالح،رنگ و يا ضريب انعكاس را  همچنين مي توانيد مProperty Pageسمت راست 
كنار اسم سطح در ليست در گوشه  " "با كليك كردن روي فضاي خالي.انتخاب كنيد

 .سمت چپ،اسم نيز مي تواند اصلاح شود

 
 شبكه محاسبه و خروجي سطح اثاثه



به منظور . انتخاب شده باشد،شبكه مي تواند تعريف شودCalculating Gridاگر تب 
 براي.را انتخاب كنيد Automaticحد كافي دقيق محاسبات ،تنظيمات اجراي سريع و به 

 . تيك انتخاب بزنيدResult Outputمربع داشتن نتايج خروجي در 
 



 :فصل پنجم
 :ديوارها و سطوح محاسبه,ويرايش پنجره ها

اينان فقط مي توانند , به طرح اضافه شوندDrag & Dropدرها و پنجره ها مي توانند با 
 .در ديوارها قرار بگيرند

 
 وارد كردن درها به طرح

ور از آنجا كهدر و پنجره ها  فقط در ديوارها مي توانند قرار بگيرند در ايت تصوير در بط
 .اتوماتيك عمودي در نزديكترين ديوار قرار ميگيرد



 
 سطح محاسبه شفاف

سطح محاسبه سطحي است كه در آن شدت روشنايي بدون اثر توزيع نور مي تواند 
سطح تراز ,براي مثال سطح كار.چندين سطح محاسبه معيار وجود دارد.محاسبه شود

 ....صحيح براي بيمارستان ها و
اين .سطح محاسبه بطور شفاف نمايش داده شده است,همانطور كه در تصوير مي بينيم

سطح وقتي از جانب ديگري .سطحي است كه نتايج محاسبات را فراهم مي كند,سطح 
اين .هيچ نتايجي براي سطح نامرئي محاسبه نشده اند,مشاهده مي شود نامرئي مي باشد

 .شوند... چرخانده و , گذارياشيا مي توانند مانند ديگر اثاثه مقياس
 



 :فصل ششم
 :ويرايش و آرايش روشناييها,الحاق

 :روشنايي هاي انفرادي
 Drag & Dropروشنايي ها مي توانند به اتاق از درخت پروژه يا درخت روشنايي ها با 

روشنايي به اتاق در موقعيت .به سادگي روشنايي را از درخت به اتاق بكشيد.ملحق شوند
)X,Y ( گيردكه شما آن را رها مي كنيد قرار مي. 

در آينده . به داخل اتاق ملحق كنيدDrag & Dropشما مي توانيد روشنايي ها را فقط با 
 هايي را تجهيز مي كنند كه از آنها روشنايي ها مي Pluginبرخي از سازندگان روشنايي

 .در موقعيت قرار بگيرند Drag & Drop توانند با

 
 الحاق روشنايي ها

 يك صفحه خواص .Inspector كليك كنيد در Guideر  دInsert Single Luminaireروي 
 روشن شده تيره وrubberband  آرايش با خطوط CADدر .متناظر با آن باز مي شود

در صفحه خواص مقادير ابتدايي نمايش داده شده اند و در قسمت تحتاني آن .است
مي توانيد ,وابسته به تب در حال حاضر فعال . قرار گرفته اندCancel  وInsertكليد هاي 



 مي توانيد روشنايي را براي قرار Luminaire Property Pageدر .موقعيت را تنظيم كنيد
 .يدگرفتن انتخاب كن

 
 ليست انتخاب روشنايي

در اين ليست مي توانيد روشناييهايي را كه به پروژه وارد كرديد پيدا كنيد مانند 
 .روشنايي كه آخرين بار استفاده كرديد

 
  تعريف اطلاعات تكنيكي روشنايي ها



در درخت پروژه .براي اصلاح دادهاي تكنيكي روشنايي ها بايد به اتاق ملحق شده باشند
 در اين مورد.(يي هاي بكار رفته در آرايش زير نوع آرايش ليست شده استروشنا

individual luminaire arrangement.(مي ,در صورتيكه يكي از روشنايي ها را انتخاب كنيد
 CADاگر روشنايي هاي متعددي را در .توانيد داده هاي تكنيكي آن را اصلاح كنيد

 .نايي هاي انتخاب شده را اصلاح كنيدمي توانيد مقادير همه روش,انتخاب كنيد



 :همترازي روشنايي
روي . براي روشنايي ها سوئيچ كردhelp مي توان روي تشعشعات DIALUX 2.0در 

و - را نشان مي دهدlevel  C0كه جهت -C0يك نشانه , كليك كنيدآيكون
ز  اC0سطوح .در روشنايي الحاقينمايان ميشود-°0 =درجه تشعشعات گاما-يك خط زرد

 . نشان داده مي شوندXروشنايي ها اغلب به سوي محور 



 :الحاق فيلد روشنايي
  يا گزينهGuide از Insert Luminaire Fieldروشنايي ها مي توانند با انتخاب 

Luminaire Arrangement Wizard ->Field Arrangementاگر شما . در محل قرار بگيرند
 براي اتاق باز مي contextك كنيد منوي يك اتاق را انتخاب كنيد وسپس راست كلي

 . را انتخاب كنيدInsert -> Field Arrangementهمچنين مي توانيد گزينه .شود
Wizardاگر از . يكي پس از ديگري درباره پارامترهاي مهمي كه بايد وارد شوند مي پرسد

 Inspectorگزينه هايي كه با آن فيلد روشنايي بطور دستي وارد شده استفاده مي كنيد 
 . را نشان مي دهدcancel يا  Insertعلاوه بر فيلد روشنايي كليد 

 
 Wizardالحاق فيلدهاي روشنايي بدون 

همه . مشخص كنند فيلد آرايش نمايان مي شودrubberband را بزنيد  Insertوقتي 
 .پارامترها را مي توان در صفحه خواص قبل و بعد از الحاق فيلد تغيير داد

اگر روي يك روشنايي . انتخاب كنيدCADيش يك روشنايي آن را از درخت يا براي ويرا
اگر .بطور قرار دادي كليه روشنايي ها در فيلد انتخاب مي شوند,در فيلد كليك كنيد 

 .مي خاهيد روشنايي ها را تكي ويراست كنيد  بايد فيلتر انتخاب را تغيير دهيد



 
                                                                        انتخاب فيلد يا ويراست اشيا ويژه                                      

 :فيلتر هاي بالا از چپ عبارتند از
 منحصر كردن انتخاب ديوار �
 )سطح محاسبه,در,پنجره(منحصر كردن انتخاب سطوح �
 منحصر كردن انتخاب آرايش روشنايي  �
 وشنايي تكي درون يك آرايشمنحصر كردن انتخاب ر �
 منحصر كردن انتخاب اثاثه �

 
 دستكاري يك روشنايي درون آرايش



تصوير نشان مي دهد كه چگونه روشنايي ها مي توانند درون يك آرايش اصلاح 
مكان روشنايي ها تغيير .فيلتر انتخاب اجازه انتخاب روشنايي هاي تكي را مي دهد.شوند

د زمانيكه جهت چراغهاي روشناييها به سمت اثاثه است اين گزينه مي توان.نكرده است
 خواص روشنايي مي تواند تغيير داده Inspector در .مورد استفاده قرار گيرد

 .همچنين امكان انتخاب نوع آرايش و نوع كادر بندي فيلدهاي روشنايي وجود دارد.شود

 
 انتخاب نوع آرايش روشنايي

در .ش انتخاب شده مانند كادر بندي خواص فيلد را تحت تاثير قرار مي دهدنوع آراي
.ورژن  هنوز امكان تغيير كادر بندي وجود ندارد  

 
 تاثير نوع آرايش روي فيلدهاي روشنايي

 
نوع آرايش نيز وارد محاسبه , ويرايش شدند CAD  زمانيكه فيلدهاي روشنايي توسط 

 .مي شود



 
  روشنايي وابسته به نوع آرايشالحاق فريمهاي فيلدهاي

 

 ممكن براي فيلد روشنايي نشان داده Edit يا  Insert سه فريم CAD در نماي 
خط چين آبي بيروني , انتخاب شده""Symmetrical Within هنگاميكه نوع آرايش.شده

 و داخلي ترين فريم "Outer Edge to Outer Edge"فريم مياني هنگاميكه .ظاهر مي شود
كادر بندي . ظاهر مي شود"Luminaire Centre to Luminaire Centre"ا انتخاب قرمز ب

مي توانيد وسعت .روشنايي ها و نقطه شروع و پايان فيلد بطور متناظر تغيير مي كند
روي فيلد راست )CADدر درخت يا (براي اينكار.فيلد روشنايي را با موس تغيير بدهيد

مي توانيد وسعت را تغيير ,تصات يك گوشه با كشيدن روي يك خط يا مخ.كليك كنيد
 توجه داشته باشيد كه حجم و "لطفا. همان كاري كه با اثاثه مي كرديد"دقيقا,دهيد

 .البته سايز روشنايي ها همان باقي مي ماند



 
 روشنايي هاي بكار رفته در آرايش

همانطور كه در تصوير بالا مي .اري شوندروشنايي ها در يك آرايش مي توانند دستك
بينيد روشنايي ها و لامپهاي استفاده شده در فيلد بدون اجبار در پاك كردن فيلد مي 

  .توانند اصلاح شوند

 
 چرخاندن آرايش و روشنايي ها

 و چرخش روشنايي هاي داخل فيلد مي توانند بصورت عددي يا "چرخش فيلد كلا
 .گرافيكي انجام شوند

 . چرخاندن يك روشنايي در يك فيلد بايد به تنهايي انتخاب شودبراي

 
 مكان فيلد روشنايي



 .مكان فيلد روشنايي نيز مي تواند بصورت عددي يا گرافيكي اصلاح شود



 :الحاق خطوط روشنايي
 . يا بطور دستي مي توانند در موقعيت قرار بگيرندWizardخطوط روشنايي نيز بوسيله 

موقعيت و زاويه مي توانند بصورت گرافيكي اصلاح , خط يا يك طول بعد از الحاق يك
 .شوند

 
 luminaire lineمقياس گذاري يك 

زاويه و طول خط .موقعيت را تغيير مي دهيد, را در وسط خط با موس بكشيدcrossاگر 
طول را تغيير داده ,اگر يكي از نقاط آبي انتهايي خط را بكشيد.ثابت باقي مي مانند

 باز contextروي خط راست كليك كنيد تا منوي .ويه و موقعيت ثابت مي مانندزا.ايد
 .شود



 
 luminaire lineچرخاندن يك 

 كليك چپ كنيد روي نقطه سبز چرخش و مـوس را  luminaire lineبراي چرخاندن يك 
 . موقعيت و طول خط ثابت مي مانند. حركت بدهيد



 :به صف كردن روشنايي ها
مي توانيد چرخش   , انتخاب كنيد  CADرا بصورت تكي در آرايش توسط       اگر روشنايي ها    

 .مكان روشناييها ثابت مي ماند.آنها را در آرايش تغيير دهيد

 
 به صف كردن روشناييهاي تكي در يك آرايش

فيلتر هاي انتخاب ,به منظور انتخاب روشنايي هاي منحصر به فرد در يك آرايش
 .بايستي تنظيم شوند

 
 CADفيلتر انتخاب براي 

 
 .چهارمين انتخاب از سمت چپ انتخاب روشنايي هاي تكي را ممكن مي سازد



 :الحاق حلقه هاي روشنايي
اي براي تثبيت موقعيت آرايش حلقه هاي روشنايي در ))wizard((زمانيكه هيچ 

علاوه . داده شد مي باشدگزينه ها خيلي شبيه آنچه تا كنون توضيح,دسترس نمي باشد
 .را نشان دهيم)) زاويه پايان((و )) زاويه شروع((بر اين ما مي خواهيم 

 
 زاويه شروع و پايان حلقه روشنايي

-mid(اولين روشنايي در مكان سمت راست نقطه وسط , است°0وقتيكه زاويه شروع 

point( در فاصلهr روي يك خط مستقيم موازي محور xقرار مي گيرد . 
اگر .موجب حركت خلاف جهت عقربه هاي ساعت مي شوند)°0>(واياي مثبت ز

 هر كدام به سمت بيرون  C0سطح ,روشنايي هاي منحصر به فرد چرخانده نشده باشند
 .مي درخشد



 :تفكيك روشنايي ها
روشنايي الحاقي مي تواند به روشنايي هاي منفرد با راست كليك كردن روي آرايش 

همچنبن مي توانيد .كان روشنايي منفرد مي تواند اصلاح شودهمزمان م.تفكيك گردد
 :يك آرايش منتخب را به روشنايي هاي منفرد تفكيك نماييد با استفاده از

  
Edit -> Split Luminaire Arrangement menu option 



 



 :فصل هفتم
 :3Dكار در نماي 

امكان پرسه زدن در يك چشم انداز برنامه ريزي شده براي ارزيابي دقيق نتايج وجود 
كه اين وقتيكه . موقعيت ناظر مي تواند داخل اتاق نيز باشدDIALUX 1.Xبرخلاف .دارد

 .اتاق هاي بزرگ با اثاثه زياد را برنامه ريزي مي كنيم اهيت دارد

 
 له از بالاارزيابي راه پ

اگر يك موس .كليد وسطي موس است)) Move((گزينه ,اگر يك موس سه كليده داريد
 كنيد و با فشار آن "Zoom" مي توانيد wheelبا چرخاندن)wheel mouse(گردان داريد

"Move  
 : استفاده مي شوند 3Dبراي تغيير موقعيت در نماي)از چپ(ابزار هاي زير 

 

 
Toolbar بين مد هابراي سوئيچ كردن  



Select Objects 
اشيا بسته به فيلتر انتخاب مي توانند با كليك كردن ,زمانيكه اين مد انتخاب شده است

 .روي آنها انتخاب شوند
Increase/Decrease View Size 

كليك چپ كنيد و موس را ,CAD در پنجره zoomبراي بزرگ يا كوچك كردن فاكتور 
 .بالا و پائين ببريد

 Increase Pane Size 
 .با كليد چپ موس فريم را در محيط بكشيد تا بزرگ شود

Rotate 3D View 
 .كليك چپ كنيد و در حاليكه كيد موس را فشار داده داريد حركت بدهيد

Move 
از آن براي حركت دادن ناحيه اي كه در پنجره نمايش داده شده است استفاده 

 در كليد وسط موس تعبيه شده "ولااگر يك موس سه كليده داريد اين گزينه معم,كنيد
 .است

Roam Scene 
عقب و چرخيدن حول ,كليك چپ موس و حركت دادن موس براي حركت به جلو-

 .موضع
در نتيجه مي توانيد به چپ و راست و بالا و پائين ,ctrlكليك چپ و نگه داشتن كليد -

 جهتهاي ديد ثابت مي ماننو,پرسه بزنيد
در نتيجه شما روي موضع مي مانيد و مي , را نگه داريدshiftكليك چپ كنيد و كليد -

 .توانيد اطرافتان را نگاه كنيد



 



 :فصل هشتم
 :ويرايش اتاقها

 :ويرايش اتاق موجود
تادر درخت پروژه ويرايش شود و ,روي آن راست كليك كنيد,براي ويرايش يك اتاق

يك جايگزين ديگر كليك كردن روي . را انتخاب كنيد Edit Room Dimensionsگزينه
Edit Room Geometry در منوي Editسومين راه ممكن كليك روي . مي باشدEdit Room 

Geometry در"Guide"توصيه شده است كه ابعاد اتاق را هنگاميكه در نماي . مي باشد
ground planهستيد تغيير بدهيد . 

 
 )راست كليك روي اتاق( اتاق contextمنوي 

 

 
DIALUX را به مد "Edit Room Dimensions"مي برد . 

 . اصلاح شود" تواند منحصرااتاق مي ground plan ,بعد از اينكه اين گزينه دستيابي شد



 
 مد ويرايش اتاق

با كليك كردن روي , موازي با مكان هاي قبلي شان,CADمي توانيد ديوارها را در نماي 
, براي حركت دادن مختصات اتاق ها به مكان ديگري در اتاق. حركت دهيد"آنها متقابلا

عيتي روي ديوار روي هر موق.روي آن كليك كنيد و سپس به مكان دلخواه حركت دهيد
ديگر .كليك راست كنيد, context در اين مكان توسط منوي Pointبراي الحاق يك 

اضافه يا  Property Page مي توانند در Further room coordinates )(مختصات هاي اتاق
 يا    Insert Coordinates     با كليك كردن روي ستون متناظر و انتخاب,پاك شوند

 Delete Coordinates. همچنين مي توانيد مختصات را به صورت عددي وارد كنيد و ابعاد
Max  اتاق را بوسيله Length  وWidthسپس كليه طولها به صورت متناظر . وارد كنيد

 .تبديل مي شوند



 :تكثير يك اتاق موجود
  به آساني ساخته ميDuplicateبا كليك كردن , )identical( مشابه"يك اتاق دقيقا

 را از منوي Duplicate سپس فرمان,ابتدا اتاق اصلي را در درخت انتخاب كنيد.شود
context و يا بوسيله Edit -> Duplicate Roomانتخاب كنيد . 

اگر مي .تكثير مي شوند..) ,مصالح,ابعاد( توجه كنيد كه فقط اطلاعات اتاق "لطفا
 :مانند قبل اقدام كنيد,نيدرا كپي ك) اثاثه و روشنايي ها(خواهيد اشيا داخل اتاق 

 .ابتدا اتاق اصلي را تكثير كنيد �
كليه اثاثه اي را كه بايد در اتاق كپي شده موجود ,در درخت پروژه اتاق اصلي �

 .باشند انتخاب كنيد

 
 كپي اشيا از يك اتاق به ديگري

اگر همه اشيا پي در پي بايد . استفاده كنيدctrlاز كليد ,  براي اضافه كردن اشيا تكي-
 .استفاده كنيدshift  انتخاب شوند از كليد 



 انتخاب context را از منوي paste روي اتاق كپي شده كليك راست كنيد و گزينه -
 .كليه اثاثه و آرايش روشنايي ها به اتاق دوم كپي مي شود.كنيد



 :اضافه كردن يك اتاق
 را Room Wizard يا Custom Edit New Room ,براي اضافه كردن يك اتاق به پروژه تان

 . انتخاب كنيدGuideدر

 
 اضافه كردن يك اتاق جديد

 . انجام دادInsert -> Roomالبته مي توان اين كار را با 

 
 اضافه كردن يك اتاق

 



 :فصل نهم
DXFنقشه مسطحه به عنوان بك گراند : 

 :DXFالحاق 
 وجود background  به عنوانDXF ground plan  امكان بار كردن فايلهايDIALux 2.0 در

 .دارد
 .بسازيد) rectangular ( يك اتاق مسطتيلي خالي-
 . برويدground plan  به نماي-
 .  كليك كنيدDXF Import and Layer به روي انتخاب  , CAD  در منوي-

 
 DXFگزينه هاي الحاق 

 . را انتخاب كنيدDXFدايركتوري و فايل ,Load... dialog box از روي �
 . نمايش داده شده اندCADانتخاب شده اند در  listboxلايه هايي كه در  �
به طور اتو ماتيك ليست لايه هاي , اضافي را اضافه كنيدDXFمي توانيد فايلهاي  �

 .ده بلندتر مي شوندنمايش داده ش
آنها را انتخاب كنيد , نيازي به آنها نيستlistbox براي برداشتن لايه هايي كه در �

 . كليك كنيدDelete و سپس روي
� DIALuxتلاش مي كند كه مقياس درست را با انتخاب اولين مقياس - starting 

with the bigger scales -100  پيدا كند كه در آن اتاق كوچكتر ازm ظاهر مي 
 .شود



 
 DXFانتخاب مبدا مختصات و مقياس براي لايه هاي 

 
اينجا ضريب مقياس . را انتخاب كنيدAlign,  Import / Manage DXF در تب  �

 . مي تواند اصلاح شودDXF گذاري در رسم
شما مي توانيد مبدا مختصات را با كليك كردن روي وضعيت مربوطه در نماي  �

ground plan رويو كليك كردن  Set DXF Originتعيين كنيد . 
 تغيير وضعيت دهيد و مختصات اتاق را مطابق با مكان تعريف edit سپس به مد �

پنجره و در را هنگام ,همچنين مي توانيد اثاثه.شده با ترسيم حركت دهيد
 . به عنوان بك گراند ملحق كنيدDXFاستفاده از فايل هاي 



 
 DXFحه با بك گراند ويرايش ابعاد اتاق در نماي نقشه مسط

 



 :3D  درنمايDXFكار با بك گراند 
به هر حال تمام . ِ استفاده كنيدDXF نيز مي توانيد از بك گراند3Dدر نماي 

مبدا مختصات در .  تعريف شده باشندground plan بايد در نماي "تنظيمات قبلا
 . نمي تواند اصلاح شود3Dنماي 

 
 DXF با بك گراند 3Dنماي 

 



 :فصل دهم
 :خروجي

 :نمايش نتايج محاسبات
اتاق را نمايش مي 3Dنماي DIALux ,بعد از اينكه محاسبات پايان پذيرفت

انواع خروجي كه .خروجي پروژه مي تواند قبل يا بعد از محاسبات ديده شود.دهد
اينها به .تحت تاثير نتايج محاسبات نمي باشند در هر زماني قابل مشاهده مي باشند

مختصات ,مختصات روشنايي,ليست قطعات روشنايي, پروژهcover sheet ثالعنوان م
اگر يكي از اين .اغلب انواع خروجي لازم است ابتدا محاسبه شوند.مي باشند... اتاق و

 DIALux ,خروجي ها هنگاميكه هنوز هيچ نتيجه اي محاسبه نشده باز شده باشند

بين خروجي پرينت  DIALux ؟تحقيق مي كند كه آيا لازم است محاسبه انجام شود
مانيتور كارشناسان زا قادر مي سازد كه فقط .و خروجي مانيتور فرق قائل مي شود

بدون آنكه توسط سايز طرح يا صفحه محدود ,اطلاعات لازم را ارزيابي كنند
كه در .جداول بزرگ نشان داده شده اند و مي توانند با حركت مشاهده شوند.شوند

 .وس قابل استفاده مي باشداينجا با كليد وسط م
 



 
 خروجي مانيتور يك جدول روشنايي بزرگ 

اگر شما از كليد .در گوشه هاي پنجره قرار گرفته اند) Scroll bars(خطوط نوشته
وسطي موس استفاده كنيد آيكون نوشته ظاهر مي شود و شما مي توانيد با حركت 

جي پرينت از مانيتور قبل مي توانيد براي ديدن خرو.دادن موس آن را هدايت كنيد
 . استفاده كنيد print preview از اينكه پرينت شود از

 DIALux  "WYSIWYG, What you see is what you get". را ساپورت مي كند. 
 به خاطر "لطفا.استفاده كنيدPrint Preview -ile   F <از,print previewبراي رفتن به 

 print ي كه با تيك مشكي انتخاب شده اند درداشته باشيد كه فقط انواعي از خروج

previewبسته به اسكوپ توليد خروجي زمان . و خروجي پرينت وجود خواهند داشت
 .يك پنجره اطلاعات حالت جاري را نشان مي دهد.مي برد



 
 Print previewوضعيت توليد 

print previewشما را به يك ديد كلي ) overview (جهز از خروجي انتخاب شده م
 .مي كند

 
Print preview 

تعيين , بسته به پرينترتان,در اينجا همچنين مي توانيد تنظيمات پرينت بيشتري را
براي كارهاي پرينت بزرگتر توصيه شده كه پرينت هاي متعدد را يكي پس از .كنيد

بزرگ " نسبتاRAM اگر)e.g. Page 1- 30, Page 31- 55 .(ديگري بفرستيد
 .ه اينكار نمي باشدنيازي ب) 128>(است



 :تنظيمات خروجي
خروجي .براي بسياري از نوع هاي خروجي  تنظيمات بيشتري مي توان معين كرد

 Propertyانتخاب كنيد و تنظيمات را در )output tree (مربوطه را در درخت خروجي

Page متناظر در inspector دهيد  تغيير. 

 
 تنظيمات خروجي

اگر از اين كليد . فعال مي شود"Refresh View" كليد,داگر تنظيمات را تغيير دهي
 3D .استفاده كنيد تغييرات وارد شده در پنجره خروجي به كار گرفته مي شوند

 . تنظيم شدهCADتوليد شده با استفاده از موقعيت ناظر در 



 
 

3D CAD  براي ويراست(در بالا سمت چپ(3و تعبيرD) در گوشه راست )به عنوان خروجي 



 : خروجي استاندارد تعريف شده توسط كاربرخلق
  را توليد و ذخيره DIALuxكاربر بارها مي تواند تركيبات استفاده شده انواع خروجي در

 .كند
 .بدين منظور يك كه شامل خروجي است بايد در درخت پروژه انتخاب شود

 
 خلق خروجي هاي استاندارد

پروژه را در درخت .وان مثال پروژهبه عن,از بالاترين سطح سلسله مراتب شروع كنيد
اگر مايليد كه از يك استاندارد از پيش  .DIALux1در اين مثال,پروژه انتخاب كنيد

براي توليد يك .انتخاب كنيدName listboxاين را از ,تعيين شده استفاده كنيد



. عنوان خروجي را كه بايد در استانداردتان قرار گيرند با تيك انتخاب كنيد,استاندارد
در بر گيرنده ,خروجي مي باشد  به خاطر داشته باشيد كه ليست شامل تمام انواع"لطفا

را  Isolines (E)براي مثال اگر شما نوع خروجي .آنها از پايين ترين سطح سلسله مراتب
اين همچنين در كليه مراحل پايين تر ,در اين مرحله از سلسله مراتب انتخاب كنيد

 مي توانيد مراحل پايين تر سلسله مراتب را انتخاب كنيد اكنون شما.انتخاب شده است
 مي توانيد اتاق را انتخاب "مثلا.و يك خروجي استاندارد متفاوت در اينجا استفاده كنيد

كه در اين مثال , را انتخاب كنيد "Complete Documentation"كنيد و استاندارد
اق ها تحت تاثير اين تغيير ساير ات. خيلي وسيع را توصيف مي كندdocu-mentationيك

 به پروژه " كه قبلاShort Documentationهمان طور كه استاندارد خروجي.نمي باشند
 .اختصاص داده شده هنوز استفاده مي شود

از آن راه از -بنابراين مي توانيد زير دايركتوري هاي خروجي منفرد را ترغيب كنيد 
ن شما اين اختيار را داريد كه انواع خروجي را البته علاوه بر اي.استاندارد جهاني برگرديد

 . براي هر شئ در درخت خروجي انتخاب كنيد"منحصرا
براي استفاده از يك استاندارد خروجي تعريف شده توسط كاربر به عنوان تنظيم قرار 

 Name در. كليك كنيد As Standard انتخاب كنيد و روي Name listboxآن را از,دادي

listbox , براي پاك . استاندارد در براكت ها پشت سر نام متناظر ظاهر مي شودعبارت
 كليك .Deleteآن را انتخاب كنيد و روي ,كردن يك استاندارد تعريف شده توسط كاربر

ديگر پاك شده قبلي در , انتخاب شدName listbox بعد از انكه استاندارد ديگري از.كنيد
  .دسترس نمي باشد

 



 :فصل يازدهم
 تنظيمات و گزينه ها

 تنظيمات
Customization 

 تنظيمات گرافيك
Configuration Wizardتبديلگر نمايشگر  

تنظيمات انتخاب DIALux 2.0 . را با نيازمندي هايتان وفق بدهيدDIALux 2.0 مي توانيد
اولويت هاي كاربر در سيستم ويندوز زير .شده توسط هر كاربري را به حافظه مي سپرد

  روي يك كامپيوتر DIALux 2.0 اگر كاربران مختلفي با. شما سازماندهي شدهlogin نام
تنظيمات شخصي و آخرين ,  شخصي داردlogin در شرايطي كه هر كاربر, كار كنند
 Global (تنظيمات كلي.ي انتخاب شده براي هر كاربر مجزا استفاده مي شودگزينه ها

settings (مي تواند توسط: 
Tools -> Options 

 .تغيير كند
 گزينه ها

 گزينه هاي خروجي
 پيش تنظيم مقادير استاندارد

 آدرس طراح
 اپراتور

 )Global options (گزينه هاي كلي
  Value chart تنظيمات

 وفق دادن سايز دياگرام روشنايي



Customization: 
 Customize با گزينه هاي.زير منوهاي متعددي در دسترس هستند , Tools در منوي

Keyboard… و  Toolbars… مي توانيد آيكون هاي درون  toolbar  راهمان طور كه 
همچنين فرامين ويژه اي مي توانند به كليد هاي . كنيدdelete  ياadd, sortمطلوب است 

 نماي F8 "مثلا.(شان داده شده استدر منو ن "Shortcut" .ويژه اي اختصاص داده شوند
3Dرا باز مي كند ( 
 

 
 

Customize the Toolbar  



 
Customize the Keyboard  



 :تنظيمات گرافيك
DIALux 2.0يك برنامهCADبر اساس تكنولوژي "Open GL" تبديل كننده . مي باشد

مبدل .نندهاي نمايشگر مدرن مي توانند به صورت بهينه از اين تكنولوژي استفاده ك
يا فقط ان را به صورت جزيي ,هاي نمايشگر قديمي اين تكنولوزي را ساپورت نمي كنند

محاسبات مورد نياز , داشته باشيد"خوب"اگر شما يك مبدل نمايشگر.ساپورت مي كنند
مد سخت (براي نمايشگر را در دست دارد و پروسس براي پروسس هاي ديگر

اين سير كردن و چرخش هاي هموار را حتي در .دآزاد خواهد بو) accelerationافزاريا
البته حتييك مبدل نمايشگر خوب محدوديت هاي .مناظر پيچيده فراهم مي كند

 rendering timesو سپس نياز به اندكي.خودش را در يك شمارش چند پهلوي معين دارد
 .بيشتر دارد

اسبات گرافيكي لازم است پروسسور مح, داشته باشيد"بد"اگر شما يك مبدل نمايشگر 
) rendering times(كمي زمان ترجمه,بسته به سخت افزار ,اين نياز ها .را انجام دهد

همچنين پرسه زدن و چرخش پيوسته در يك اتاق ممكن نمي .بيشتري نياز دارد
 .فقط حركت هاي قدم به قدم ممكن مي باشند,باشد

روي , شما در طول چرخش تكان مي خورد3Dاگر متوجه شديد كه نمايش
 اتوماتيك براي((گزينه

wireframe display  هنگاميكه در داخل نماي CAD كليك كنيد,حركت مي كنيد((. 
)Tools -> Optionsبه مد "نمايشگر موقتا,در طول چرخش هاي جهتدار )را ببينيد 

wireframe گوشه هاي بيشتر در .از اين راه حركت روان ممكن مي شود.سوئيچ مي شود
 .محاسبات بيشتر را براي نمايش لازم مي كنند,يك چشم انداز 



  :configuration wizard مبدل نمايشگر 
 رابراي وضوح "Open GL"اكثر مبدل هاي نمايشگر فقط سخت افزار سرعت دهنده

  .certain colour depths( (e.g. 16 bit)(و اعماق رنگ معين(e.g. 1024 x 768)معين 
ه اينكه مبدل هاي نمايشگر كدام مد را ساپورت مي براي پي بردن ب.ساپورت مي كنند

مراقب . برويد تا پارامترهاي مربوطه را ببينيد…Tools -> Graphics Settingsبه,كنند
 .تبصره هاي هر قدم رابا دقت  بخوانيد تا از نقايص سخت افزار جلوگيري كنيد,باشيد 
 :توجه

تبديل .رخي مانيتورها شوندتنظيمات معين مبدل نمايشگر مي توانند باعث خرابي ب
اين ممكن است باعث .كننده نمايگر اغلب فركانس بالاتر از مانيتور را ساپورت مي كند

 .نقايصي در مانيتور شود

 
DIALux graphics settings 



 
Display adapter configuration wizard start screen 

حتي . را بايد استفاده كندچه وضوح تصويري DIALuxدر اينجا مي توانيد تعيين كنيد 
 DIALuxاستفاده مي كنيد مي توانيد براي كار با x 768 pixel 1024از وضوح "اگر معمولا

 DIALuxوضوح بيشتر فقط زماني فعال مي شود كه .از وضوح بيشتري استفاده كنيد

 بيت استفاده مي كنيد اين 32همچنين زمانيكه از عمق رنگ بيش از .استفاده مي شود
اما مبدل نمايشگرتان سرعت سخت افزار در اين عمق رنگ را فراهم نمي , مي افتداتفاق
 براي دست يافتن به سرعت سخت افزار مي توانيد عمق DIALux هنگام استفاده از. كند

 . انتخاب كنيد(e.g. 24 bit)رنگ پائين تري 
 آنها را مدهاي گرافيكي گوناگون كه كارتتان, را باز كنيدGraphics Mode اگر ليست

 اگر مي خواهيد مدها را امتحان كنيد اين..ساپورت مي كند مي توانند ديده شوند

warningديده مي شود . 



 
  مبدل نمايشگرconfiguration wizard اخطار

صبر كنيد تا صداي بيپ بشنويد .مهم است كه مانيتور را در طول تست هاخاموش كنيد
 .اين ممكن است چند دقيقه طول بكشد.يدقبل از آنكه دوباره مانيتور را روشن كن

 :تبصره
 .اگر كامپيوترتان كارت صدا دارد اسپيكرها را روشن كنيد تا صداي بيپ را بشنويد

 
Wizard براي ممانعت از گوشه هاي تيره 

 اتاق محاسبه شده 3D مي توانيد از اين گزينه براي ممانعت از گوشه هاي تيره در نماي
به تبديل خاكستري .وت اندكي بين تصاوير در حقيقت وجود دارداغلب تفا.استفاده كنيد

 .به سفيد در گوشه پايين تر تصوير توجه كنيد اين بايد همانند تصوير سمت چپ باشد



 
 با گوشه هاي تيره3D CAD  بدون گوشه هاي تيره                نماي3D CADنماي 

 بدون گوشه هاي تيره CAD ربرخي از مبدل هاي نمايشگر مي توانند سرعت سخت افزا
اين گوشه ها باعث خطا در محاسبات نمي شوند و روي آن هيچ جا اثر .را فراهم كنند
 . تاثير مي گذارندscreenفقط روي نمايش .نمي گذارند

 

 
Setting the polygon offset 



اين تنظيمات لازم . سطوح به درد مي خورد صحيح براي نمايشwizard اين بخش از
يا سوسو زدن روشنايي ها يا هرچه در يك قسمت ,در ها ,ديل شوداگر پنجره هااست تع

لغزنده خيلي از چپ دور (نمايش داده شده هنگاميكه يك اتاق را در نماي مي چرخانيد
 ).است

درها يا سطوح درخشان روشنايي ها به نظر مي رسد ,حد ديگر زماني است كه پنجره ها
 .)لغزنده خيلي از چپ دور است.( ستاز ديوار چند سانتي متر جلوتر ا

 
 لغزنده خيلي به راست دور نزديك است .polygon offsetتنظيم غلط 

لغزنده را تنظيم كنيد تا شكل در راست با شكل در چپ مچ شود ولي تا جاييكه ممكن 
 .است آن رااز راست دور نگه داريد



 :گزينه هاي خروجي

 
 گزينه هاي خروجي

 logo به طور ايده آل فرمت. و پانويس خروجي را تعريف كنيدlogo در اينجا مي توانيد
 . باشدx 26 pixel 108  ياcm x 1,0 cm 4,5 بايد

 
 مثال يك استاندارد براي طرح خروجي



 
 مثال يك استاندارد براي طرح خروجي



 :تنظيم مقادير استاندارد از پيش

 
  پيش تنظيم مقادير استاندارد

 چه مقادير استانداردي را بايد استفاده DIALux تعيين كنيددر اينجا مي توانيد 
اين مقادير به عنوان پيش فرض استفاده مي ,هنگام ساختن اتاق هاي جديد.كند
البته مي توان ارزش هاي جاري و استانداردهاي از پيش تعييت شده را در هر .شوند

 .زمان تغيير داد



 :آدرس طراح

 
 آدرس طراح

اين در بالاي خروجي .ني كه طرح نقشه را انجام داده وارد مي شوددر اينجا ادرس كمپا
 . پروژه استفاده مي شوندProperty Page اين ها در.ظاهر مي شود

 
 مثال يك طرح خروجي استاندارد



 :اپراتور

 
 اپراتور

 .در اينجا مي توانيد اطلاعات اپراتور را وارد كنيد

 
 مثال يك طرح خروجي استاندارد



 :اي كليگزينه ه

 
 گزينه هاي كلي

DIALux راه "Project Directory:" را به عنوان يك دايركتوري استاندارد براي پروژه هاي 
متناظرتوسط راه نامبرده ,dialog box  كليك كنيدSaveاگر روي .شما استفاده مي كند

 . انتخاب شده باز مي شود "در بالا كه قبلا
 بايد استفاده كند را انتخاب DIALux ني كه مي توانيد زبا":Language" در جعبه

 در,زبان هاي به روز شده. در حال افزايش است"تعداد زبان هاي در دسترس دائما.كنيد

homepage de.dial.www.در دسترس است . 
DIALux 2.0يك كتابخانه  وسيعundo يد تعداد مراحلدر اينجا مي توان. دارد"Undo" را 
 64اگر شما يك . شما تنظيم گردد RAMبايد مطابق با سايز.undo optionتنظيم كنيد

MB RAMمرحله را انتخاب كنيد20نبايد بيش از ,داريد . 
 .تصوير خوش آمد كه در شروع برنامه ظاهر مي شود مي تواند روشن يا خاموش شود

 توصيه شده كه,ر داريد يا يك مبدل نمايشگر قديمي تlaptopاگر
Automatically change to wireframe display when moving within the CAD views "

"option. اگر در. را انتخاب كنيدCAD ست  حركت مي كنيد ماداميكه اين گزينه فعال ا
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بعد از آنكه كليد موس رها ,به دنبال حركت موس, مي شودupdateتصوير اتاق به نرمي,
 .چشم انداز كلي يكبار ديگر نمايش داده مي شود,شد

اگر پيكانهاي . سوئيچ كنيد wireframe پرتابي بود به 3D CADاگر حركات در نماي
 Coordinate arrows visibleگزينه , مشخص باشند3D بايد در نمايZ  و X, Yمختصاتهاي

in 3Dرا روشن كنيد. 



 :تنظيمات جدول ارزش

 
 تنظيمات جدول ارزش 

در اينجا مي توانيد تنظيمات براي پيدايش جداول ارزش و مقادير در خروجي را تعريف 
 .كنيد

 



 

 



 :وفق دادن سايز دياگرام هاي روشنايي ها

 
 وفق دادن سايز دياگرامهاي روشنايي

 نيازي به تغيير "معمولا.وانيد سايز دياگرام هاي روشنايي را وفق دهيددر اينجا مي ت
تنظيمات نمي 

.باشد



 ترجمه از سحر محمدي
 mohammadi_505@yahoo.com           

 


